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AKVIS MAGNIFIER AI 12.0 | УВЕЛИЧИВАЙТЕ И УЛУЧШАЙТЕ ИЗОБРАЖЕНИЯ

AKVIS Magnifier AI позволяет увеличивать размер и качество фотографий с помощью обученных нейросетей.
Программа служит для увеличения и улучшения снимков, рисунков, сжатых изображений, изображений с текстом и т. 
д. Увеличивайте разрешение и качество фотографий с помощью Magnifier AI!

 

AKVIS Magnifier AI — эффективная программа для увеличения изображений. Программа помогает создать фотографию
размером с плакат или увеличить разрешение для лучшего качества печати, сохраняя детализацию и четкость.

При изменении размера изображений в большинстве программ используются самые простые алгоритмы интерполяции.
Для уменьшения фотографии их вполне достаточно. Если же вы захотите увеличить фотографию, то обязательно
столкнетесь с проблемой потери качества из-за недостатка информации. Обычные алгоритмы не справляются с такой
сложной задачей.

С помощью AKVIS Magnifier AI можно создать увеличенное изображение высокого качества из маленькой картинки.
Программа позволяет увеличение изображения до 800%.
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Программа использует инновационные технологии искусственного интеллекта и машинного обучения и позволяет
создавать изображения отличного качества.

AKVIS Magnifier AI включает в себя два режима увеличения изображений на основе искусственного интеллекта:
Стандартный и Усиленный алгоритмы.

Стандартный алгоритм рекомендуется для обработки фотографий хорошего качества без заметных шумов и
артефактов сжатия. В этом режиме Magnifier AI увеличивает размер изображения, сохраняя детали и текстуру и
повышая контрастность.
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Усиленный алгоритм подходит для иллюстраций, рисунков, фотографий, сохраненных в низком качестве, сильно
сжатых изображений, скачанных из Интернет, изображений с текстом и для подготовки к печати крупных форматов. В
этом режиме программа увеличивает изображения, удаляя шум и дефекты сжатия и подчеркивая границы.
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AKVIS Magnifier AI выполняет работу по увеличению изображения без искажения цвета, без дорисовки лишних
деталей, что является недостатком многих других нейронных сетей.

Эта программа на основе искусственного интеллекта позволяет получить изображение сверхвысокого разрешения,
создать гигапиксельные постеры и панорамы большого формата. Magnifier AI — незаменимый инструмент для
профессионалов.

Программа обеспечивает многократное увеличение фотографии без артефактов и ореолов, сохраняет края четкими и
выразительными, удаляя при этом нежелательные шумы и дефекты.

AKVIS Magnifier AI позволяет создавать профессионально выглядящие изображения высокого качества. Используйте
программу для увеличения изображений из соцсетей, мессенджеров, фотографий, снятых камерой с  низким
разрешением, а также для улучшения результатов кадрирования.

Magnifier AI позволяет быстро и в автоматическом режиме изменять размер множества изображений.  Пакетная
обработка позволяет увеличивать или уменьшать с одними и теми же настройками группу фотографий.
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AKVIS Magnifier AI представлен в виде самостоятельной программы (Standalone) и в виде плагина (Plugin) для
Photoshop и Photoshop Elements. 
Для вызова плагина Magnifier AI в Adobe Photoshop, выберите в меню: Файл -> Автоматизация -> AKVIS Magnifier
AI.
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УСТАНОВКА НА WINDOWS

Следуйте инструкции, чтобы установить программу AKVIS на Windows (на примере AKVIS Magnifier AI).

Для установки программы необходимо обладать правами администратора.

Перед установкой плагина необходимо закрыть графический редактор, в который будет устанавливаться плагин. Если
установка плагина была выполнена при запущенном графическом редакторе, то его необходимо перезапустить.

 

1. Запустить программу установки двойным щелчком по файлу exe.
2. Выбрать язык программы и нажать на кнопку Установить (Install).
3. Ознакомиться с  Лицензионным Соглашением, при согласии с его условиями выбрать пункт "Я принимаю

условия лицензионного соглашения" ("I accept the term in the license agreement") и нажать на кнопку Далее
(Next).

4. Для установки  плагина нужно выбрать из списка графический редактор (или редакторы), в который будет
устанавливаться плагин.

Для установки  версии standalone (отдельной программы) должен быть выбран соответствующий вариант —
Standalone.
Для создания ярлыка программы на рабочем столе должен быть выбран компонент Ярлык на рабочий стол
(Desktop Shortcut).

Нажать на кнопку Далее (Next).

5. Нажать кнопку Установить (Install).
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6. Запустится процесс установки программы.

7. Можно подписаться на рассылку AKVIS и получать новости об обновлениях программ, ссылки на обучающие
статьи и специальные предложения. Для этого введите свой адрес e-mail и подтвердите согласие с политикой
конфиденциальности.
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8. Нажать кнопку Готово (Finish) для выхода из программы инсталляции.

После установки программы AKVIS Magnifier AI в главном меню Start (Пуск) появится пункт AKVIS -> Magnifier AI,
a на рабочем столе — ярлык программы AKVIS Magnifier AI (если при установке было выбрано создание ярлыка).

Внимание: Чтобы запустить плагин Magnifier AI в редакторе Photoshop, воспользуйтесь командой File -> Automate ->
AKVIS Magnifier AI, в Photoshop Elements: File -> Automation tools -> AKVIS Magnifier AI.

Внимание! Если плагин не установился в графический редактор автоматически, можно подключить его вручную. Для
плагина Magnifier AI скопируйте файлы 8li и 8bf из папки программы в папку плагинов.
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УСТАНОВКА НА MAC

Следуйте инструкции, чтобы установить программу AKVIS на Mac (на примере AKVIS Magnifier AI).

Для установки программы необходимо обладать правами администратора.

 

1. Открыть виртуальный диск dmg:

- akvis-magnifier-app.dmg для установки версии Standalone (отдельной программы)

- akvis-magnifier-plugin.dmg для установки версии Plugin.

2. Ознакомиться с Лицензионным соглашением и нажать кнопку Agree.

3. Откроется окно Finder с приложением AKVIS Magnifier AI (в случае установки отдельной программы) или, в
случае установки плагина, с папкой AKVIS Magnifier AI Plugin.

 

Для установки версии standalone приложение AKVIS Magnifier AI переместить в папку Applications.

Для установки версии plugin приложение AKVIS Magnifier AI Plugin перенести в папку с плагинами графического
редактора:

AliveColors: любая папка, указанная в настройках редактора,

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC,

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins,

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-Ins.
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Плагины на Mac
(кликните на изображение для увеличения)

Внимание: Все плагины AKVIS вызываются в Photoshop из меню Filter/Effects, кроме Magnifier AI. Чтобы запустить
плагин  Magnifier AI в редакторе Photoshop, выберите  File -> Automate -> AKVIS Magnifier AI, в Photoshop
Elements: File -> Automation tools -> AKVIS Magnifier AI.

Версия standalone (приложение) запускается обычным способом — двойным щелчком по файлу.

Также можно запустить программу AKVIS из приложения  Фото, выбрав команду  Изображение ->
Редактировать в (в High Sierra и более поздних версиях macOS).
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УСТАНОВКА НА LINUX

Следуйте инструкции, чтобы установить программу AKVIS (версию standalone) на Linux (на примере AKVIS Magnifier
AI).

Примечание: Программы AKVIS совместимы только с  64-битным ядром Linux версии 5.x или более поздней.
Узнать версию ядра можно с помощью команды uname -srm.

Установка программ AKVIS возможна для разных дистрибутивов Linux:

► пакет DEB: Debian/Ubuntu/Astra Linux

► пакет RPM: Red Hat/CentOS/Fedora/РЕД ОС/Rosa Linux

► дистибутивы ALT Linux

► дистрибутив openSUSE

 

Установка в системах на основе Debian (например, Astra Linux).

Примечание: Для установки программы необходимы разрешения apt-install или apt-get.

1. Запустить терминал.
2. Создать каталог для хранения ключей: 

sudo mkdir -p /usr/share/keyrings
3. Скачать ключ, которым подписан репозиторий: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
или wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Добавить репозиторий в список, где система ищет пакеты для установки: 
e c h o  ' d e b  [ a r c h - = i 3 8 6  s i g n e d - b y = / u s r / s h a r e / k e y r i n g s / a k v i s . g p g ]  h t t p s : / / a k v i s -
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Обновить список известных пакетов: 
sudo apt-get update

6. Начать установку программы AKVIS Magnifier AI: 
sudo apt-get install akvis-magnifier

7. Установка завершена.

Запустить AKVIS Magnifier AI через терминал или ярлык программы.

8. Для автоматического обновления используется команда: 
sudo apt-get upgrade

для удаления программы: 
sudo apt-get remove akvis-magnifier --autoremove

 

Установка в системах на основе RPM (например, РЕД ОС).

1. Запустить терминал.
2. Зарегистрировать ключ, которым подписан репозиторий 

sudo rpm --import https://akvis.com/akvis.asc
3. Добавить репозиторий в систему 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Обновить список пакетов

при использовании менеджера пакетов dnf: 
sudo dnf update

при использовании менеджера пакетов yum: 
sudo yum update

5. Установить программу AKVIS Magnifier AI

при использовании менеджера пакетов dnf: 
sudo dnf install akvis-magnifier

при использовании менеджера пакетов yum: 
sudo yum install akvis-magnifier

6. Установка завершена.

Запустить AKVIS Magnifier AI через терминал или ярлык программы.

7. Для автоматического обновления

при использовании менеджера пакетов dnf: 
sudo dnf upgrade
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при использовании менеджера пакетов yum: 
sudo yum upgrade

8. Для удаления программы

при использовании менеджера пакетов dnf: 
sudo dnf remove akvis-magnifier

при использовании менеджера пакетов yum: 
sudo yum remove akvis-magnifier

 

Установка в системе ALT Linux.

Примечание: Для установки программы необходимы разрешения apt-install или apt-get.

1. Запустить терминал.
2. Войти как root-пользователь: 

su -
3. Добавить репозиторий в систему 

e c h o  " r p m  h t t p : / / a k v i s - a l t . s f o 2 . c d n . d i g i t a l o c e a n s p a c e s . c o m  x 8 6 _ 6 4  a k v i s "  |  t e e
/etc/apt/sources.list.d/akvis.list 
e c h o  " r p m  h t t p : / / a k v i s - a l t . s f o 2 . c d n . d i g i t a l o c e a n s p a c e s . c o m  n o a r c h  a k v i s "  |  t e e  - a
/etc/apt/sources.list.d/akvis.list

4. Обновить список известных пакетов: 
apt-get update

5. Установить программу AKVIS Magnifier AI: 
apt-get install akvis-magnifier

6. Установка завершена.

Запустить AKVIS Magnifier AI через терминал или ярлык программы.

7. Для автоматического обновления используется команда: 
apt-get dist-upgrade

для удаления программы: 
apt-get remove akvis-magnifier --autoremove

 

Установка в системе openSUSE.

1. Запустить терминал.
2. Войти как root-пользователь.
3. Добавить ключ, которым подписан репозиторий 

rpm --import http://akvis.com/akvis.asc
4. Добавить репозиторий в систему 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Обновить список пакетов: 

zypper ref
6. Установить программу AKVIS Magnifier AI: 

zypper install akvis-magnifier
7. Установка завершена.

Запустить AKVIS Magnifier AI через терминал или ярлык программы.

8. Для автоматического обновления используется команда: 
zypper update

для удаления программы: 
zypper remove akvis-magnifier

 

Для правильного отображения интерфейса программы рекомендуется установить композитный менеджер Compton или
Picom.
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АКТИВАЦИЯ ПРОГРАММЫ

Внимание! Ваш компьютер должен быть подключен к сети Интернет.

Если подключение к Интернет недоступно, ниже предлагается альтернативный способ активации.

 

Скачать установочный файл AKVIS Magnifier AI (на странице программы или на странице загрузки).

Запустить скачанный файл и установить программу, следуя подсказкам мастера установки.

Запустить установленную программу. Окно О программе всегда показывается при запуске незарегистрированной
копии программы. Кроме того, окно  О программе выводится при нажатии кнопки   на Панели управления

программы.

При работе с плагином в редакторе Adobe Photoshop окно О программе может быть вызвано на экран выбором
команды меню Help -> About Plug-In –> Magnifier AI на Windows, Photoshop -> About Plug-In –> Magnifier AI на
Mac.

 

При нажатии кнопки Попробовать откроется окно, где можно выбрать тип лицензии для ознакомления. Если пробный
период истёк, кнопка будет неактивна.

В течение ознакомительного периода (10 дней) доступна любая лицензия: Home (Plugin либо Standalone), Deluxe или
Business. При выборе лицензии рядом будет отображен пояснительный текст с кратким описанием данного типа
лицензии. В зависимости от выбора будут доступны разные возможности AKVIS Magnifier AI.

Для получения более полной информации о версиях и лицензиях программы  AKVIS Magnifier AI смотрите
сравнительную таблицу.

 

При нажатии кнопки Купить будет открыто окно, где необходимо указать приобретаемый тип лицензии.

После выбора лицензии необходимо снова нажать кнопку Купить. В браузере откроется страница заказа, где можно
продолжить подбор программ либо приступить к оформлению покупки.

После заполнения формы и проведения денежной транзакции серийный номер будет выслан в течение нескольких
минут.

 

Чтобы зарегистрировать программу, нажать на кнопку Активировать. Откроется следующее окно:
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В поле Имя пользователя ввести имя, на которое будет зарегистрирована программа.

Внимание! Длина имени пользователя на кириллице не должна превышать 21 символ.

В поле Серийный номер ввести номер, полученный после оплаты заказа.

Ниже выбрать способ активации - через прямое соединение с сервером или через электронную почту.

Прямое соединение с сервером

Рекомендуется данный способ активации, как наиболее быстрый.

Компьютер должен быть подключен к сети Интернет.

Нажать на кнопку Активировать для завершения активации.

Отправить запрос по e-mail

Eсли был выбран способ активации через e-mail, то при нажатии на кнопку Активировать будет автоматически
создано письмо, которое, не редактируя, необходимо отправить по указанному адресу.

Если компьютер не подключен к Интернет, нужно записать созданное письмо на внешний носитель (диск или
"флешку") и отправить с другого компьютера, на котором есть доступ к сети. Все, что нам нужно, уже будет
записано в самом письме.

Если письмо не создается, просто пришлите нам серийный номер (код лицензии) программы и HardwareID (HWID)
компьютера, на котором установлена программа.

В ответ будет получено письмо с вложенным файлом Magnifier.lic, который следует поместить в папку, где
хранится лицензионная информация о программе. Это папка AKVIS в Общих документах пользователей:

Windows:

C:\Users\Public\Documents\AKVIS;

Mac:

/Users/Shared/AKVIS или домашняя папка пользователя;

Linux:

/var/lib/AKVIS.

Активация программы завершена.
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При желании можно произвести апгрейд до версии Home Deluxe или Business, доплатив разницу в цене. Для этого в
окне О программе необходимо нажать кнопку Улучшить (в зарегистрированной версии появляется на месте кнопки
Купить).

В открывшемся окне выбрать желаемую лицензию и нажать кнопку  Улучшить. При этом в браузере откроется
страница заказа, где можно оплатить выбранный апгрейд.

После оплаты вы получите сообщение, что ваша лицензия обновлена, после чего потребуется переактивировать
программу.

При нажатии кнопки Отменить происходит возврат в окно О программе.

При возникновении вопросов или проблем обратитесь в службу поддержки - support@akvis.com.
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ОПИСАНИЕ РАБОЧЕЙ ОБЛАСТИ

Программа AKVIS Magnifier AI может работать как отдельная программа и как плагин к графическим редакторам
Adobe Photoshop и Photoshop Elements.

Запустить программу.

При первом запуске программы появится сообщение о возможности скачать и установить модуль CUDA для работы с
нейросетями.

 

Окно программы AKVIS Magnifier AI выглядит следующим образом:

Рабочая область программы AKVIS Magnifier AI

Элементы окна программы:

Центральную часть окна программы AKVIS Magnifier AI занимает Окно изображения с закладками До и После.  В
закладке До находится исходное изображение, а в закладке После – изображение после обработки. Переключаться
между ними можно щелчком левой кнопки мыши по названию закладки. Для того чтобы сравнить исходную картинку с
результатом, достаточно щелкнуть левой кнопкой мыши в любой точке изображения: пока кнопка удерживается
нажатой, будет показано изображение на другой закладке.

Внешний вид Окна изображения и закладок можно настроить с помощью кнопок в нижней части  Панели
инструментов.

Внимание! При переключении между закладками будет наблюдаться небольшое искажение пропорций рисунка −
это следствие одновременного масштабирования двух изображений, которое не влияет на результат работы
программы. Чтобы свести видимое смещение деталей к минимуму, рекомендуется работать с изображениями на
масштабах определённой кратности (50%, 100%, 150% и т. д.).

 

В верхней части окна расположена Панель управления с кнопками:

Кнопка   позволяет перейти на домашнюю страницу программы AKVIS Magnifier AI.
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Кнопка   (только в отдельной программе)  предназначена для открытия изображения. Открыть изображение

можно с помощью горячих клавиш Ctrl+O  на Windows, ⌘ +O  на Mac. 
При щелчке правой кнопкой мыши будет показан список последних использованных файлов, сортированных по
времени открытия. Длина списка задаётся в окне изменения настроек программы.
Кнопка   (только в отдельной программе) предназначена для сохранения результата. Диалог сохранения

файла вызывается также нажатием клавиш Ctrl+S  на Windows, ⌘ +S  на Mac.
Кнопка   (только в отдельной программе) предназначена для  вывода изображения на печать. Быстрая

отправка на печать производится нажатием клавиш Ctrl+P  на Windows, ⌘ +P  на Mac.
Кнопка   (только в отдельной программе) вызывает диалоговое окно пакетной обработки фотографий.

Кнопка   запускает процесс обработки изображения.

Кнопка   (только в плагине) предназначена для применения результатов и закрытия окна плагина.

Кнопка   предназначена для вызова сведений о программе.

Кнопка   (либо клавиша F1 ) предназначена для вызова справки помощи по программе.

Кнопка   вызывает диалог изменения настроек программы.

Кнопка   вызывает панель оповещений со свежими новостями о программе.

Слева от Окна изображения находится Панель инструментов c инструментами:

Кнопка   (только в отдельной программе) активирует инструмент Кадрирование, с помощью которого можно

удалить часть изображения.
Кнопка   активирует инструмент Рука, который позволяет двигать фотографию, когда она не помещается в

Окне изображения при выбранном масштабе. Для перемещения необходимо нажать на кнопку, подвести курсор
к изображению и, удерживая левую кнопку мыши нажатой, передвинуть в нужную сторону.
Двойным щелчком по кнопке   изображение масштабируется под размер окна программы.

Кнопка   активирует инструмент  Лупа, предназначенный для изменения масштаба изображения. Для

увеличения масштаба необходимо щёлкнуть левой кнопкой мыши по изображению в окне программы. Для
уменьшения масштаба изображения щелчок производится с нажатой клавишей Alt .

Двойным щелчком по кнопке   можно развернуть изображение в натуральную величину (100%).

Перемещение по изображению и масштабирование осуществляется с помощью Навигатора. Рамкой в Навигаторе
отмечается та часть изображения, которая в данный момент является видимой в Окне изображения; области за
пределами рамки будут затенены. Рамку можно перетаскивать, меняя видимую часть изображения. Для перемещения
рамки необходимо поместить курсор внутрь рамки и, удерживая левую кнопку мыши, выполнить перетаскивание.

Навигатор

Для прокрутки изображения в Окне изображения можно использовать полосы прокрутки или нажать на пробел и
перетаскивать изображение левой кнопкой мыши. Прокруткой колёсика мыши изображение можно перемещать вверх-
вниз, удерживая  Ctrl  – вправо-влево, удерживая  Alt  − масштабировать. При щелчке правой кнопкой мыши на
полосе прокрутки появится меню быстрых перемещений.

С помощью ползунка можно масштабировать изображение в Окне изображения. При перемещении ползунка вправо
происходит увеличение масштаба изображения; влево - уменьшение масштаба изображения.

Также масштаб изображения изменится, если ввести в поле масштабирования новый масштабный коэффициент. Часто
используемые масштабы помещены в выпадающее меню поля масштабирования.

Для увеличения масштаба изображения можно воспользоваться клавиатурными сокращениями: +  и Ctrl++  (⌘ ++  на
Mac), для уменьшения масштаба -  и Ctrl+-  (⌘ +-  на Mac).

 

Под Навигатором расположена Панель настроек с параметрами дополнительной обработки изображения. C помощью
горячих клавиш Alt+буква можно быстро установить курсор в нужное поле ввода.

На панели Пресеты понравившиеся настройки программы можно сохранить как пресет и использовать в дальнейшем.
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Внизу выводится подсказка: краткое описание параметров и кнопок, на которые наведён курсор. Изменить
местоположение окна подсказки можно в Настройках программы.
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РАБОТА С ПРОГРАММОЙ

AKVIS Magnifier AI использует алгоритмы машинного обучения, с помощью которых можно изменять размер
изображений в пределах от 1 до 800%  без потери качества. Сравните, как выглядит одно и то же изображение,
увеличенное в 8 раз.

Увеличение изображения с помощью программы

Чтобы увеличить или уменьшить изображение, требуется проделать следующие шаги:

Шаг 1. Открыть изображение.

- В отдельной программе (файл в формате TIFF, BMP, JPEG, WEBP, RAW или PNG):

Диалоговое окно  Выберите файл можно вызвать  сразу после запуска программы с помощью двойного
щелчка мыши в области Окна изображения или кнопкой   на Панели управления. Кроме того, можно

перетащить ярлык изображения в открытое окно программы или редактора.

- При работе с плагином:

В графическом редакторе Adobe Photoshop с помощью команды меню Файл -> Открыть или сочетания
клавиш  Ctrl+O  на Windows,  ⌘ +O  на Mac вызвать диалог открытия изображения и выбрать требуемый
файл.

Удостовериться, что слои слиты, иначе плагин не может быть вызван, и выбрать пункт меню:

File -> Automate -> AKVIS Magnifier AI в Adobe Photoshop,
File -> Automation tools -> AKVIS Magnifier AI в Adobe Photoshop Elements.
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Окно программы AKVIS Magnifier AI с исходной фотографией
Шаг 2. В отдельной программе перед изменением размера можно использовать инструмент Кадрирование 

для удаления ненужных частей изображения. Настройки инструмента будут показаны на Панели настроек.

Чтобы отсечь области, не попавшие в кадр, следует нажать  OK или клавишу  Enter . Если нужно отменить
операцию - кнопку Отмена или  Esc . Чтобы вернуть область кадрирования к исходному состоянию, достаточно
выбрать кнопку Сброс.

Кадрирование изображения
Шаг 3. Задать требуемое изменение размера в поле Ширина или Высота (в пикселах, процентах, мм, см или
дюймах) с учётом Разрешения. Обратите внимание, что максимальное увеличение составляет 800%.

AKVIS Magnifier

22



Изменение размера изображения
Шаг 4. При увеличении размера изображения выбрать алгоритм увеличения:

A. Стандартный. Увеличивает изображения, сохраняя мелкие детали. Рекомендуется для фотографий в
высоком качестве, без шума и артефактов сжатия.

B. Усиленный. Увеличивает изображения, удаляя шум и дефекты сжатия, подчеркивает границы. Подходит
для фотографий, сохраненных в низком качестве, иллюстраций, рисунков и изображений с текстом.

Стандартный алгоритм

Усиленный алгоритм

Настроить параметр  Сглаживание (0-25). Количество удалённых деталей. Большие значения приводят к
размытию изображения.
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Сглаживания нет Сглаживание = 20

Резкость = 0 Резкость = 80

Сглаживания нет Удаление шума = 25

Шаг 5. При уменьшении изображения будут активны параметры:

Резкость (0-100). Повышает чёткость изображения за счёт увеличения цветового контраста между
соседними пикселами.

Удаление шума (0-25). Степень сглаживания шума. Большие значения приводят к размытию изображения.

Шаг 6. После настройки параметров нажатием кнопки   запустить процесс обработки. Результат будет

показан на закладке После. Если в программе используется Автозапуск, расчёт видимой области проиcходит
сразу. Нажатие кнопки Отмена (справа от индикатора выполнения процесса) прерывает обработку изображения.

Внимание! Увеличение изображения является ресурсоёмким процессом и требует больших объёмов
оперативной памяти и наличия 2-3 Гб свободного места на диске C:/ для swap-файлов. При увеличении 5-
10 мегапиксельной картинки на 400% площадь изображения возрастает в 16 раз + 200-300 Мб, откуда
видно, что на обработку требуется около 1,5 Гб памяти.

Шаг 7. Настройки можно сохранить как пресет и использовать в дальнейшем. Для сохранения настроек
необходимо в группе Пресеты ввести имя для пресета и нажать на кнопку Сохранить.

Настройки выбранного пресета являются значениями по умолчанию, и при следующем запуске программы все
параметры примут эти значения. Если значения параметров были изменены, то для возвращения исходных
настроек используется кнопка Сброс.

Для удаления пресета необходимо выбрать его из списка пресетов и нажать на кнопку Удалить.
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Для того чтобы обработать изображение с помощью пресета, необходимо выбрать соответствующий пресет из
списка и нажать на кнопку  .

Панель пресетов
Шаг 8. В стандалон-версии AKVIS Magnifier AI есть возможность распечатать изображение.
Шаг 9. Сохранить изображение.

- В отдельной программе:

Нажать на кнопку   и в диалоговом окне Сохранить изображение ввести имя файла, указать формат

(TIFF, BMP, JPEG, WEBP или PNG) и выбрать каталог, в который необходимо сохранить файл.

- При работе с плагином:

Нажать на кнопку  , чтобы применить результат. Окно плагина  AKVIS Magnifier AI закроется, и

изменённое изображение появится в окне графического редактора.

В графическом редакторе  вызвать диалог сохранения файла командой меню  Файл -> Сохранить как,
ввести имя файла, указать формат и выбрать каталог, в который необходимо сохранить файл.

Ниже приведён результат изменения размера изображения с настройками, указанными на скриншоте.

Фрагмент изображения, увеличенного в 4 раза
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НАСТРОЙКИ ПРОГРАММЫ

Диалог изменения настроек программы вызывается кнопкой   и имеет вид:

Язык программы. Для переключения интерфейса программы на другой язык необходимо выбрать язык из
выпадающего списка.
Масштаб интерфейса. В списке можно выбрать размер элементов интерфейса. При выборе значения  Авто
масштаб интерфейса автоматически подстраивается под разрешение экрана.
Интерфейс. Переключаясь между цветами, можно выбрать стиль оформления программы - светлый или темный.
Масштаб изображения при загрузке. Возможны следующие варианты:

- изображение масштабируется Под размер окна. Масштаб подгоняется так, чтобы оно было полностью
видимым в Окне изображения;

- при значении 100% изображение не масштабируется. В большинстве случаев при открытии в масштабе
100% в окне программы будет показана лишь часть изображения.

Чек-бокс Автозапуск. В режиме автозапуска любое изменение настроек или перемещение по изображению
автоматически запускает процесс обработки. При работе в обычном режиме обработка запускается после
нажатия кнопки  .

Отображение подсказок. В данном блоке задаётся местоположение окна подсказок.

- Справа на панели настроек;
- Слева под окном изображения;
- Не отображать.

Последние открытые файлы. Количество файлов, отображаемых в списке недавно открытых документов при
правом клике мышью по кнопке   (сортированы по времени открытия). Максимальная длина списка - 30

файлов.
Чек-бокс  Закрепить панель управления блокирует возможность сворачивания панели. Разблокированную
панель можно сворачивать и разворачивать щелчком по маленькой треугольной стрелке. Свёрнутая панель
всплывает при наведении курсора.

Для принятия изменений в окне Настройки нажмите ОК.

При необходимости можно вернуть исходные значения параметров, нажав на кнопку По умолчанию.
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ПАКЕТНАЯ ОБРАБОТКА ФОТОГРАФИЙ

В программе AKVIS Magnifier AI существует возможность редактирования серии фотографий с помощью пакетной
обработки.

Пакетная обработка файлов может быть полезна при коррекции большого количества фотографий, сделанных в
одинаковых условиях с одними и теми же настройками фотоаппарата.

Процесс обработки пакета фотографий

Подробная инструкция по работе с отдельной программой находится здесь.

Узнать о работе с плагином можно по ссылке.
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ПЕЧАТЬ ИЗОБРАЖЕНИЙ

Режим  Печать отвечает за подготовку изображений к распечатке на принтере. Перейти в режим печати можно
нажатием кнопки   на Панели управления.

Режим печати

Настроить печать выбранной фотографии можно с помощью параметров на Панели настроек:

В первом блоке из списка доступных принтеров выбрать нужный и указать необходимое разрешение, а также
задать количество печатных копий.

В блоке  Ориентация страницы задать положение листа при печати:  Альбомная  -  лист расположен
горизонтально или Книжная - лист расположен вертикально.

При нажатии на кнопку Параметры страницы открывается диалоговое окно, в котором можно выбрать размер и
ориентацию бумаги при печати, а также задать ширину полей печати.

Нажатием кнопки Сброс полей можно вернуть полям страницы исходные размеры.

В следующем блоке можно настроить размер изображения для печати с помощью параметров  Масштаб,
Ширина, Высота и Под размер страницы. Они не влияют на изображение, а только на его печатную копию.
Изменить размер печатной копии можно либо указав Масштаб изображения в %, либо задав новые значения для
параметров Ширина и Высота.

Чтобы распечатать изображение во всю страницу, следует выбрать чек-бокс Под размер страницы. Если чек-
бокс неактивен, то положение картинки можно задать с помощью стрелок справа или перетаскиванием мышью.

В блоке Рамка можно задать ширину и цвет рамки вокруг изображения.

В блоке Цветной фон с помощью цветовой пластины можно вызвать стандартный диалог выбора цвета и задать
цвет страницы.

В закладке  Страница можно настроить расположение одной или нескольких копий изображения на одной
странице.
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Печать страницы
С помощью параметра Копии указать количество копий обработанной фотографии на одной странице.
Параметрами  По горизонтали  и   По вертикали задать количество строк и столбцов для размещения
фотографий.
С помощью параметра Отступ задать ширину отступа между копиями фотографий.

На вкладке Постер можно настроить печать одного изображения на нескольких страницах для последующего
объединения в одно большое полотно.

Печать постера
Чек-бокс Страницы. При активном чек-боксе в поле справа можно задать количество страниц, на которое
будет поделена фотография. Масштаб изображения изменится, чтобы максимально заполнить все страницы.
При неактивном - программа автоматически подберет оптимальное число листов в соответствии с
фактическим размером изображения (масштаб = 100%).
Чек-бокс Поля для клея. При активном чек-боксе в поле справа можно задать ширину отступов для
склеивания листов. Отступы будут оставлены с правого и нижнего краев при печати страницы.
Чек-бокс Нумерация страниц. При активном чек-боксе на полях страницы будет напечатан номер ее
позиции в столбце и строке.
Чек-бокс Линии отреза. При активном чек-боксе на полях страниц будут напечатаны линии, по которым
можно отрезать лишние части распечатанных листов.
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Для печати изображения с учетом настроенных параметров нажать на кнопку Печать. Для выхода из режима печати
нажать на кнопку Отмена.

При нажатии кнопки  Опции... будет открыт системный диалог, где можно произвести расширенную настройку и
отправить документ на печать.
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СРАВНЕНИЕ АЛГОРИТМОВ УВЕЛИЧЕНИЯ

Программа  AKVIS Magnifier AI предназначена для увеличения изображений и содержит для этого несколько
алгоритмов на основе нейронных сетей:

Стандартный. Алгоритм предназначен для увеличения фотографий в высоком качестве, без шума и артефактов
сжатия. При увеличении сохраняет мелкие детали и текстуру материалов, из-за этого может принимать пикселы
шума за важные детали изображения и увеличивать их тоже.

Усиленный. Алгоритм предназначен для увеличения фотографий, сохраненных в низком качестве, иллюстраций,
рисунков и изображений с текстом. При увеличении удаляет шум и дефекты сжатия, подчеркивает границы, но
вместе с тем может сгладить мелкие детали или текстуру на изображении.

 

Рассмотрим увеличение различных изображений, сохраненых в разном качестве.

Пример 1. Пейзажная фотография с большим количеством мелких деталей в высоком качестве.

Исходное изображение
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Стандартный. Сохранено большинство деталей.
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Стандартный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Усиленный. Мелкие детали сгладились, изображение выглядит как картина.

Усиленный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

 

Пример 2. Фотография интерьера в среднем качестве.
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Исходное изображение
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Стандартный. При увеличении текстура частично восстановлена.

Стандартный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Усиленный. Сглажено большинство мелких деталей, предметы имеют "пластиковый" вид.
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Усиленный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

 

Пример 3. Шумная портретная фотография в высоком качестве.

Исходное изображение
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Стандартный. Шум сохранился, принял вид крупных зерен.
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Стандартный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Усиленный. Шум удален.

Усиленный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

 

Пример 4. Фотография змеи, сохраненная в низком качестве.
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Исходное изображение
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Стандартный. Шум и артефакты сжатия сохранились.

Стандартный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Усиленный. Шум и артефакты сжатия пропали, чешуйки и контуры выглядят гладкими.
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Усиленный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

 

Пример 5. Иллюстрация, сохраненная в низком качестве.

Исходное изображение
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Стандартный. Артефакты сжатия сохранились.
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Стандартный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

Увеличение алгоритмом Усиленный. Артефакты сжатия пропали, контуры гладкие, области с однородной заливкой и
ровными краями.

Усиленный алгоритм
(нажмите на изображение, чтобы увидеть увеличенный фрагмент)

 

Вывод. Как можно видеть, выбор алгоритма увеличения зависит от качества и содержания исходной фотографии, а
также от желаемого результата. Если качество увеличиваемого изображения достаточно высоко и требуется
сохранить больше деталей, то стоит использовать  стандартный алгоритм. Если же качество исходной картинки
оставляет желать лучшего или результату необязательна излишняя детализация, то лучше воспользоваться
усиленным алгоритмом.
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ВЕСЁЛЫЕ БЛОШКИ

В логике есть понятие бесконечного спуска, пришедшее из математики: так называют процесс, который всё время
изменяется и  никогда не кончится. Наглядное представление о вечном спуске даёт шуточное стихотворение про
блошек, которое приписывается шотландскому математику Августу де Моргану (19 век):

 

Блох больших кусают блошки,
Блошек тех - малютки-крошки,
И нет конца тем паразитам,
Как говорят, ad infinitum.

Блоха большая, в свой черёд,
Кусает ту, на ком живёт,
Та – блох потолще, шире в талии,
И нет конца им, и так далее...

Речь идёт о бесконечном увеличении (уменьшении) размеров блох, живущих друг на друге. Несколько этапов данного
процесса легко проиллюстрировать с помощью программы  AKVIS Magnifier AI, позволяющей менять размер
изображений.

 

Шаг 1. Запустить программу AKVIS Magnifier AI.
Шаг 2. Открыть исходное изображение двойным щелчком левой кнопки мыши в области Окна изображения.
Включить режим Автозапуска (см. Настройки), чтоб отслеживать результат изменения параметров.

Исходное изображение (видимый масштаб 100%)
Шаг 3. Уменьшить изображение в 2 раза. Для этого на Панели настроек выбрать из выпадающего списка
Процент, в поле Ширина или Высота ввести 50.

Двукратное уменьшение изображения

Сохранить полученное изображение как little-flea.jpg, щёлкнув по кнопке   и задав имя файла в диалоговом

окне Сохранить изображение. Перед сохранением выполнится полная обработка изображения, как при нажатии
кнопки  .

Шаг 4. Уменьшить изображение в 4 раза: в поле Ширина или Высота ввести 25.
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Четырёхкратное уменьшение изображения

Сохранить полученное изображение как little-little-flea.jpg.

Шаг 5. Увеличить исходное изображение в 2 раза: в поле Ширина или Высота ввести 200. Выбрать алгоритм
увеличения Усиленный. В ходе изменения размера изображение будет обработано с текущими настройками.

Двукратное увеличение изображения

Сохранить полученное изображение как big-flea.jpg.

Шаг 6. Увеличить исходное изображение в 4 раза: в поле Ширина или Высота ввести 400. Алгоритм увеличения
также оставить Усиленный.

Четырёхкратное увеличение изображения

Сохранить полученное изображение как big-big-flea.jpg.

Шаг 7. Выйти из программы AKVIS Magnifier AI и соединить изображения (например, в редакторе AliveColors).

Блошки, кусающие друг друга
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ПАПАРАЦЦИ: ОХОТА ЗА СЕНСАЦИЕЙ

Будь начеку! Лови момент! Ищи сенсацию!

Подкараулив ничего не подозревающую парочку, папарацци со всех сторон слетелись к лестнице и принялись
фотографировать. Как обычно, их внимание было нацелено на пикантные детали встречи. На следующий день газеты
пестрели заголовками: "Сын миллиардера встречается с...", а первые полосы украшали фотографии - подробности
свидания крупным планом:

 

Довольно часто приходится сталкиваться с ситуацией, когда интерес представляет не всё изображение целиком, а
только его часть. В таких случаях применяется кадрирование - обрезка изображения по выделенному фрагменту. Этот
приём широко используют в фотографии для удаления лишнего фона, получения крупного плана и привлечения
внимания к одной детали.

Как правило, оставшийся после кадрирования кусок значительно меньше исходного изображения; возникает задача
увеличить его до исходного размера и распечатать без потери качества. Тут-то и приходит на помощь программа
AKVIS Magnifier AI.

 

Шаг 1. Открыть изображение в программе AKVIS Magnifier AI. Вот такой кадр попал в руки папарацци:

Исходное изображение
Шаг 2. С помощью инструмента Кадрирование  выделить нужный фрагмент. Истинный папарацци сделает

акцент на поцелуе:
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Кадрирование изображения
Шаг 3. На Панели настроек выбрать единицы измерения и задать новый размер картинки с разрешением не
меньше 300 dpi. Если готовится большая сенсация, то и фото должно быть побольше.

Окно программы AKVIS Magnifier AI
Шаг 4. Запустить обработку изображения   и сохранить результат  .
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Результат стараний папарацци

 

AKVIS Magnifier

43



МАЛЬЧИК-С-ПАЛЬЧИК

Автор примера Gordon Sisson.

 

В своём примере Gordon Sisson продемонстрировал ещё один аспект работы с программой  AKVIS Magnifier AI  –
возможность не только изменять величину, но и улучшать качество исходного изображения. Gordon Sisson является
обладателем большой интернет-коллекции изображений. Поскольку такие рисунки имеют разрешение 72 точки на
дюйм и не годятся для печати, ему довольно часто приходится увеличивать их размер и разрешение.

Он выбрал фотографию маленького мальчика - все знают, как трудно растить детей, к тому же мальчик действительно
очень мал: высота картинки всего 2,38 дюйма! Как утверждает автор, с помощью AKVIS Magnifier AI это можно
сделать за пару минут.

 

Шаг 1. Запустить программу AKVIS Magnifier AI и открыть изображение (можно перетащить файл в открытое
окно программы).

Исходное изображение (маленький мальчик)
Шаг 2. Установить в поле Разрешение 300 точек на дюйм. При этом картинка уменьшится до 0,57 дюйма в
высоту.

Изменение разрешения с 72 до 300 точек на дюйм

В поле Новый размер задать 750% и выбрать алгоритм увеличения.

Увеличение изображения
Шаг 3. Запустить обработку изображения нажатием кнопки  . После обработки высота рисунка составляет

4,28 дюйма - по сравнению с началом, мальчик "подрос" в два раза, а разрешение улучшилось в 4 раза.
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Окно программы AKVIS Magnifier AI

Сохранить изображение – теперь его можно распечатать.
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ПРОГРАММЫ КОМПАНИИ АКВИС

 

AKVIS AirBrush — Аэрографический рисунок из фотографии

AKVIS AirBrush позволяет превратить фотографию в рисунок в технике  аэрография. Программа действует как
художественный фильтр, изменяя изображение и превращая его в аэрографический рисунок в соответствии с
выбранными настройками. Подробнее…

 

AKVIS Artifact Remover AI — Улучшение качества сжатых изображений JPEG

AKVIS Artifact Remover AI — бесплатная программа для улучшения качества сжатых изображений. Программа
использует алгоритмы искусственного интеллекта для удаления артефактов JPEG, уменьшения шума и пикселизации.
Подробнее…

 

AKVIS ArtSuite — Эффекты и рамки для фотографий

AKVIS ArtSuite — коллекция рамок и эффектов для оформления фотографий. ArtSuite содержит множество готовых
шаблонов и богатую Библиотеку образцов и текстур и позволяет получить практически бесконечное количество
вариантов эффектов. Подробнее…
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AKVIS ArtWork — Имитация художественных стилей

AKVIS ArtWork имитирует художественные стили и техники живописи, создавая произведение искусства. В программе
представлены эффекты:  Масляная живопись, Акварель, Гуашь, Комикс, Перо и чернила, Линогравюра, Пастель  и
Пуантилизм. Подробнее…

 

AKVIS Chameleon — Создание коллажей

AKVIS Chameleon — программа для создания коллажей, реалистичных и фантастических. Chameleon экономит время и
силы, так как не требует точного выделения объектов,  автоматически сглаживает границы и подбирает цветовую
гамму "вставки" к цветам фона. Подробнее…
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AKVIS Charcoal — Рисунок углем и мелом

AKVIS Charcoal позволяет преобразовать фотографию в рисунок, выполненный углём и мелом. Изменяя цвета
материалов и бумаги, можно получить массу самых разнообразных эффектов, например, рисунок сангиной.
Подробнее…

 

AKVIS Coloriage — Раскрашивание изображений

AKVIS Coloriage позволяет раскрашивать черно-белые фотографии и заменять цвет на цветных изображениях,
выполнять выборочное раскрашивание и обесцвечивание. С помощью программы можно вернуть к жизни старые снимки
и придать современной фотографии винтажный вид. Подробнее…

 

AKVIS Decorator — Замена текстуры и перекраска поверхности

AKVIS Decorator — программа для изменения поверхности объекта. Decorator позволяет заменить текстуру либо цвет
выбранного объекта. При наложении текстуры сохраняется объем, изгибы, тени исходного изображения. В программе
представлена богатая Библиотека текстур:  образцы поверхностей дерева, металла, камня, травы, тканей и др.
Подробнее…
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AKVIS Draw — Создание карандашного эскиза

AKVIS Draw позволяет превратить фотографию в эскиз, выполненный простым карандашом. Программа имитирует
видение и подход истинного художника. С помощью AKVIS Draw вы можете придать любому изображению вид быстрого
карандашного наброска. Подробнее…

 

AKVIS Enhancer — Фотокоррекция с усилением детализации

AKVIS Enhancer — программа для обработки фотографий с усилением детализации изображения. Программа позволяет
проявить детали в светлых и темных областях, улучшить резкость и контрастность изображения, добавить яркость,
отредактировать отдельные цветовые области. Программа работает в трех режимах: Улучшение деталей, Допечатная
обработка и Тоновая коррекция. Подробнее…

 

AKVIS Explosion — Эффекты разрушения и распада

AKVIS Explosion добавляет на фотографии эффекты разрушения. Программа позволяет распылить объект на осколки,
превратить часть изображения в россыпь летящих частиц, создать песчаную бурю, имитировать взрыв и другие
эффекты распада. Подробнее…
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AKVIS Frames — Готовые рамки для фотографий

AKVIS Frames — бесплатная программа для оформления фотографий. Программа предназначена для работы с
пакетами рамок AKVIS. Вы можете украсить свои снимки эксклюзивными стильными рамками! Подробнее…

 

AKVIS HDRFactory — Расширение динамического диапазона

AKVIS HDRFactory — программа для создания изображений с расширенным динамическим диапазоном (HDR) из одного
или нескольких снимков, а также для коррекции яркости, контрастности, насыщенности. HDRFactory наполнит жизнью
и цветом ваши фотографии! Подробнее…

 

AKVIS LightShop — Световые и звездные эффекты

AKVIS LightShop добавляет световые эффекты на изображение. С помощью программы можно создать любого вида и
формы свечения, добавить на фотографию лучи, ореолы, вспышки, молнии, блики на объекты, закат или фейерверк.
LightShop украсит снимок, оживит пейзаж, изменит время суток и погоду. Подробнее…
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AKVIS Magnifier AI — Увеличивайте и улучшайте изображения

AKVIS Magnifier AI позволяет увеличить размер изображения и улучшить качество. Благодаря использованию
нейросетей программа обеспечивает многократное увеличение, до 800%, и создает изображения высокого разрешения.
Улучшайте разрешение фотографии, создавайте четкие изображения идеального качества, с отличной детализацией!
Подробнее…

 

AKVIS MakeUp — Ретушь портретных фотографий

AKVIS MakeUp — программа для исправления портретных фотографий. MakeUp улучшает портрет, устраняя мелкие
дефекты с поверхности кожи и придавая лицу сияние, чистоту и гладкость. Программа способна превратить обычный
снимок в фотографию с обложки, создать стильный образ и даже получить изображение в "высоком ключе".
Подробнее…
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AKVIS NatureArt — Природные явления на ваших фотографиях

AKVIS NatureArt — коллекция уникальных эффектов, имитирующих природные явления. В программу включены
эффекты: Дождь

 

AKVIS Neon — Рисунок светящимися линиями

AKVIS Neon превращает фотографию в яркий и необычный рисунок, выполненный светящимися линиями. Программа
предназначена для создания неоновых эффектов на изображении. Подробнее…

 

AKVIS Noise Buster AI — Удаление цифрового шума

Noise Buster AI — программа для подавления цифрового шума. Программа убирает шумы матрицы цифровой камеры и
шумы, появляющиеся при сканировании фотоснимка, уменьшает зернистость и устраняет неоднородные цветовые
пятна на изображении, сохраняя при этом детали и чёткость границ. Программа использует технологии искусственного
интеллекта и настройки постобработки для усовершенствования результата. Подробнее…
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AKVIS OilPaint — Эффект масляной живописи

AKVIS OilPaint — программа для имитации масляной живописи. Особенностью программы является уникальный
алгоритм наложения мазков, который наиболее достоверно воспроизводит технику работы кистью. Подробнее…

 

AKVIS Pastel — Рисунок пастелью из фотографии

AKVIS Pastel позволяет преобразовать обычный фотоснимок в рисунок, выполненный пастелью. Программа превращает
любое изображение в произведение искусства, имитируя одну из самых популярных художественных техник,
обладающую графическими и живописными свойствами. Подробнее…

 

AKVIS Points — Картины в технике пуантилизма

AKVIS Points превращает фотографии в картины в одной из самых выразительных живописных техник — пуантилизм. С
помощью программы Points вы с легкостью можете создавать великолепные произведения искусства в манере
пуантилистов. Откройте для себя мир ярких красок! Подробнее…
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AKVIS Refocus AI — Улучшение фокусировки, эффекты размытия

AKVIS Refocus AI повышает резкость нечетких фотографий, предлагает полную и выборочную фокусировку, добавляет
эффекты размытия и боке. Программа работает в пяти режимах:  Исправление фокуса AI, Миниатюра, Размытие
диафрагмы, Размытие движения и Радиальное размытие. Подробнее…

 

AKVIS Retoucher — Восстановление и ретушь фотографий

AKVIS Retoucher — программа для восстановления изображений и ретуши фотографий.

Программа поможет удалить царапины, пятна, пыль, следы от сгибов и другие дефекты; убрать лишние детали, текст;
реконструировать недостающие части фотографии, "затянуть" дырявые места и нарастить оборванные края.
Подробнее…
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AKVIS Sketch — Рисунок карандашом из фотографии

AKVIS Sketch — программа для создания рисунка из фотографии. Программа превращает фотоснимки в эскизы,
сделанные карандашом или углем, позволяет создать черно-белый карандашный набросок или цветной рисунок. В
программе представлены следующие стили:  Классический, Художественный, Маэстро  и   Мультистиль, — каждый с
набором готовых пресетов. AKVIS Sketch позволяет каждому почувствовать себя художником! Подробнее…

 

AKVIS SmartMask — Выделение объекта и удаление фона

AKVIS SmartMask — программа для быстрого выделения объектов на изображении. SmartMask позволяет быстро и
качественно вырезать часть фотографии, используется для удаления фона, создания коллажей. Подробнее…

 

AKVIS Watercolor — Рисунок акварельными красками

AKVIS Watercolor превращает фотографию в акварельный рисунок. Программа включает в себя два стиля:
Классическая акварель  и   Контурная акварель, каждый с набором готовых пресетов. Создавайте произведения
искусства в технике акварельной живописи! Подробнее…
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